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Introduction

Welcome!

LABELVIEW 8 label design and integration software provides
an easy-to-use, user-friendly solution for printing bar code
labels and tags to meet compliance standards in any industry. 

What’s New? New features in version 8 include:

• Updated Interface - New look and new toolbar buttons

• RFID label printing - Encode radio frequency tags

• New Bar Codes - UCC/EAN Composites & UCC/EAN-128 
Coupon Extended Codes

• Rich Text Fields - Advanced text formatting features

• TextArt - Allows text to be “bent” at precise angles to fit 
a selected shape type (ellipse, polygon, rectangle, etc.) 
and formatted using custom spacing, borders, and back-
grounds

• AutoSize Text - Printer resident fonts are automatically 
sized to fill a pre-sized field

• TrueType Font Flexibility - Independently change the 
width and height of TrueType fonts

• SQL Query Builder - Wizard for creating an SQL state-
ment

For a complete listing of all new features, printer drivers and
corrections in LABELVIEW 8, see the program’s Readme.txt
file.

e



Chapter 1-2 Installation Guide

LABELVIEW 
Editions

LABELVIEW label design software is available in three editions
— Basic, Pro, and Gold. (The edition and release number for
your software are printed on the security key as well as on a
label located on the LABELVIEW box.) The following table
provides an overview of the key features included in each
edition.

FEATURE Basic Pro Gold 
General
Print-only version  • • 
Network version   • 
Printer code converter   • 
Label samples • • • 
Unlimited number of fields per label (25) • •
Hidden (unprintable) objects • • • 
Graphic formats import (bmp, pcx, jpg, tif, etc.) • • • 
Color support • • • 
Color graphic reduction • • • 
Graphical bar codes • • • 
Native bar codes • • • 
Multi-level password protection  • • 
Label specific passwords  • • 
Label previews • • • 
Multilingual support • • • 
Custom bar code support • • • 
2D bar code support  • • 
HIBC support  • • 
Print to file • • 
Print to picture • • 
TextArt • •
RichTextField objects • •
Database
Database Editor (DBF and ODBC data source)  • • 
OLE DB and ODBC support  • • 
Key field access to database records  • • 
Table view/print  • • 
DSN file support  • • 
Customized SQL queries   • 
Variables
Flexible date and time stamping • • • 
Variable graphic images  • • 
Shared serial files  • • 
Linked expressions  • • 
Incrementing fields • • 
Add an offset to date  • • 
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Other LABELVIEW Configurations

LABELVIEW Full 
Design and Run-
Time Versions

LABELVIEW is available in a Full Design version and in a Run-
Time (print only) version. The Full Design version is required
in order to design, edit and save label design files. The Run-
Time version must be used in conjunction with a Full Design
version. Run-Time is limited to only opening and printing
labels; you cannot add, move, delete or edit fields on a label.

LABELVIEW Single 
and Network/
Multi-User 
Versions

A LABELVIEW Single-User version is a stand-alone program
that is intended to be installed on one PC. The LABELVIEW
Network version is a multi-user license available only with the
Gold edition. A network version must be installed on a server
that houses the security key. Only one security key is included
with a network version, pre-programmed with the number of
licenses you have purchased. (For more information, see the
"Network Installations" section on page 2-4.)

User Input Fields
Set input format • • • 
Minimum input length • • 
Pick List data entry • • • 
Tools
Directly modify printer code with Job Modifier utility • • 
LABELVIEW Symbol (industry specific symbols) • • • 
User-definable reports generated from label log 
files • 

Automatically e-mail reports to track label stock 
usage (Media Tracking)  • 

Pocket LABELVIEW support • •
Pocket LABELVIEW licenses (0) (1)
Automatic printing from a source database 
(DataWatch) • 

Print labels from serial device data (CommWatch) • 
Automatic printing based on a key field entered by 
an operator (Label Select) • 

Print labels automatically using simple instruction 
files (Command Files) • 

Visual Basic form builder • 
RFID tag support •
Programmability
OLE Client (insert WordArt, spreadsheets, etc.) • • 
OLE Automation  • 
DDE (Dynamic Data Exchange) •

FEATURE Basic Pro Gold 
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System Requirements
• IBM-compatible PC, 486 or better

• Microsoft Windows 98 SE, Windows Me, Windows NT 4.0, 
Windows 2000, Windows XP or Windows Server 2003

• 32 MB RAM with Windows 98 or Windows Me (64 MB rec-
ommended)

• 64 MB RAM with Windows NT 4.0 or Windows 2000 (128 
MB recommended)

• 128 MB RAM with Windows XP (256 MB recommended)

• 256 MB RAM with Windows Server 2003 (512 MB recom-
mended)

• Hard drive with at least 50 MB free disk space

• Parallel port if using a parallel key (security key)

• USB port if using a USB key (security key)

• Serial port if required by printer

• VGA monitor or better

• CD-ROM drive

• Mouse

Product Components 

Your label design software is packaged with the following
components:

• CD-ROM

• Documentation appropriate for the version you purchased

• A license agreement and registration card

• Software security key

The edition and release number for your software 
are printed on the security key as well as on a 
label located on the LABELVIEW box.
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Installing LABELVIEW

Before Installing
1 Disable all anti-virus software.

2 Close all other applications that are currently running.

3 Select one computer on the network to act as the key 
server (it can be the network file server or any of the 
workstations). This computer must be running in order for 
the users to access the label design software. 

You will need to install the label design software on this 
computer and then AFTER installation, attach the security 
key to the computer. (The security key should never be 
attached to the computer before or during the installation 
of the software. For more information on proper use of the 
security key, see the "Attaching the HASP Key" section on 
page 2-10.) 

Local administrative privileges are required for 
proper installation. Contact your system adminis-
trator for assistance.

e



Chapter 2-2 Installation Guide

Single User Installations

Note If you have already downloaded and installed the LABELVIEW 
8.0 Demo, there is no need to install again from the CD. To 
convert your installed demo version to a full install, close 
LABELVIEW, place the security key on the computer, and then 
launch LABELVIEW. Press F7 or go to Help menu > System 
Status and verify that the product version listed matches the 
product label on your LABELVIEW package.

Single User: Full 
Install

X To perform a full install for a Single User license:

1 Insert the CD. 

The CD’s opening screen will appear. (If the CD does not 
automatically open, on the taskbar, click the Start button, 
and then click Run. Type the letter of the CD-ROM drive 
followed by CDSetup.exe (e.g., D:\CDSetup.exe).

2 On the opening screen of the CD, select the product to 
install and then click the Install button. 

3 Follow the instructions displayed on the screen to select 
and install the software.

4 When installation is complete, attach the software security 
key as directed in the "Attaching the HASP Key" section on 
page 2-10.

5 Start the LABELVIEW software.

6 Install and select your printer. (For information on printer 
setup, see Chapter 3, "Printer Setup").

7 If desired, proceed to the "Setting Up System Security 
(Pro and Gold Only)" section on page 2-13 to set up user 
security.

Single User: 
Version Upgrade

If you are upgrading from an earlier version of LABELVIEW 
(e.g., LABELVIEW 7.0) that is currently installed on the 
computer, you should install the new version over the earlier 
version. Any configuration settings you previously set up in the 
earlier version will be saved.
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X To perform a Version Upgrade for a Single User 
license:

1 Insert the CD. 

The CD’s opening screen will appear. (If the CD does not 
automatically open, on the taskbar, click the Start button, 
and then click Run. Type the letter of the CD-ROM drive 
followed by CDSetup.exe (e.g., D:\CDSetup.exe).

2 On the opening screen of the CD, select the product to 
install and then click the Install button. 

3 Follow the instructions displayed on the screen to select 
and install the software.

4 When installation is complete, attach the software security 
key as directed in the "Attaching the HASP Key" section on 
page 2-10.

5 Follow the steps in the "Key Upgrade Procedure" section 
on page 2-12 to upgrade your security key (a required 
step in the upgrade process).

6 If system security was previously set up in the old version 
of your software, or if you want to set up user security in 
the new version, proceed to the "Setting Up System Secu-
rity (Pro and Gold Only)" section on page 2-13 to set up 
user security.

Single User: 
Edition Upgrade

If you are performing an Edition Upgrade (e.g., from
LABELVIEW 8 Pro edition to LABELVIEW 8 Gold edition) you do
NOT need to reinstall the software.

X To perform an Edition Upgrade for a Single User 
license:

• Follow the instructions in the "Key Upgrade Procedure" 
section on page 2-12 to upgrade your security key. 



Chapter 2-4 Installation Guide

Network Installations

Follow the guidelines below when installing a network/multi-
user version of the label design software:

• The LABELVIEW software must be installed on a server 
along with the License Manager application. Any worksta-
tion that will run the label design software must also have 
the software installed locally.

• The security key must be attached to the server AFTER 
the software has been installed successfully. Only one 
security key is included with a network version of the soft-
ware, pre-programmed with the number of licenses pur-
chased. (For more information on proper use of the 
security key, see the "Attaching the HASP Key" section on 
page 2-10.)

• The software directory must be shared and mapped allow-
ing full read/write access to all potential users. This is nec-
essary for the network License Manager.

Note The License Manager application is not compatible with Novell 
systems, so Novell network users must designate a Windows 
workstation to be the key server.

Network/Multi-
User: Full Install

1 Insert the CD on the computer chosen to act as the key 
server.

The CD’s opening screen will appear. (If the CD does not 
automatically open, on the taskbar, click the Start button, 
and then click Run. Type the letter of the CD-ROM drive 
followed by CDSetup.exe (e.g., D:\CDSetup.exe).

2 On the opening screen of the CD, select the product to 
install and then click the Install button. 

3 Follow the instructions displayed on the screen to select 
and install the software.

Each workstation requires a mapped letter 
drive in order to properly access the key server 
program. Refer to your Windows documentation 
or ask your system administrator for the neces-
sary instructions.
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4 When installation is complete, attach the software security 
key as directed in the "Attaching the HASP Key" section on 
page 2-10.

5 Start the LABELVIEW software. (You may see errors upon 
opening, before the network configuration has been per-
formed).

6 Install and select your printer. (For information on printer 
setup, see Chapter 3, "Printer Setup").

7 In LABELVIEW, select Configuration from the Options 
menu, and then click on the Network tab. Check the Net-

work Key box, and use the  button or Auto Find... 

button to browse to the mapped letter drive location of the 
program’s LICENSE directory.

8 Close LABELVIEW.

9 On the computer that has the key attached, run the 
LVLICENSEMANAGER.EXE application found in the 
LABELVIEW 8.0 program group. (For information on 
running License Manager as a service, e-mail 
teklynx_support@teklynx.com with a Subject line of 
“License Manager as Service”.) 

10 Start the LABELVIEW software again. If the key server 
install is configured properly, LABELVIEW will open without 
error, and License Manager should reflect one user access-
ing the program. If unsuccessful, refer to Appendix A, 
"Troubleshooting Installation Issues" before continuing.

11 Install the software on each workstation where the label 
design software will be used. Through Windows, map the 
network drive where the label design software is installed 
on the server or on the workstation where the key is 
attached. Refer to your Windows documentation or ask 
your system administrator for the necessary instructions. 

12 For each installation repeat Step 7. Only this time, browse 
to the program’s LICENSE directory on the mapped letter 
drive from Step 11.

13 Shut down and restart the label design software to com-
plete the network installation.
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14 If desired, proceed to the "Setting Up System Security 
(Pro and Gold Only)" section on page 2-13 to set up user 
security.

Network/Multi-
User: Full Install 
for Terminal/Citrix 
Server with 
Remote Desktop

1 Insert the CD on the computer chosen to act as the key 
server.

The CD’s opening screen will appear. (If the CD does not 
automatically open, on the taskbar, click the Start button, 
and then click Run. Type the letter of the CD-ROM drive 
followed by CDSetup.exe (e.g., D:\CDSetup.exe).

2 On the opening screen of the CD, select the product to 
install and then click the Install button. 

3 Follow the instructions displayed on the screen to select 
and install the software.

4 When installation is complete, attach the software security 
key as directed in the "Attaching the HASP Key" section on 
page 2-10.

5 Start the LABELVIEW software. (You may see errors upon 
opening, before the network configuration has been per-
formed).

6 Install and select your printer. (For information on printer 
setup, see Chapter 3, "Printer Setup").

7 In LABELVIEW, select Configuration from the Options 
menu, and then click on the Network tab. Check the Net-

work Key box, and use the  button or Auto Find... 

button to browse to the mapped letter drive location of the 
program’s LICENSE directory.

8 Close LABELVIEW.

9 On the computer that has the key attached, run the 
LVLICENSEMANAGER.EXE application found in the 

LABELVIEW 8.0 program group. (For information on 
running License Manager as a service, e-mail 
teklynx_support@teklynx.com with a Subject line of 
“License Manager as Service”.) 

10 Start the LABELVIEW software again. If the key server 
install is configured properly, LABELVIEW will open without 
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error, and License Manager should reflect one user access-
ing the program. If unsuccessful, refer to Appendix A, 
"Troubleshooting Installation Issues" before continuing.

11 Set up all LABELVIEW configuration options as follows: 

• On the Options menu, click Configuration. Use the 
tabs on the Configuration dialog box to set up all 
LABELVIEW configuration settings that you want to be 
available for all users (i.e., network licensing, printing 
options, display language, etc.).

• On the Options menu, click Directories. Use the 
Directories dialog box settings to specify the direc-
tory path for each data source option you want to be 
available for all users.

• Configure any other Options menu settings (serial 
files, accumulator files, label inventory, etc.) that you 
want to be available for all users.

12 After all configuration options are set, close LABELVIEW to 
update the label.ini configuration file with the new set-
tings.

13 Set up all remote terminals.

Now you can log onto the server or any remote terminal 
and the configuration file will be copied to each user as the 
user logs into the workstation or server and executes the 
LV.exe program file.

With Terminal Server/Citrix Server installations, 
each terminal will have its own unique 
LABELVIEW configuration file. For this reason, 
you MUST set all configuration options before 
setting up each remote terminal. Note that if 
system security is desired, this will also need to 
be set up BEFORE setting up the remote 
terminals. For information on setting up system 
security, see the "Setting Up System Security 
(Pro and Gold Only)" section on page 2-13.
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Network/Multi-
User: Version 7.0 
to 8.0 Upgrade

1 Verify that both LABELVIEW version 7.0 and License Man-
ager are closed. 

2 Remove the security key.

3 Insert the CD on the computer chosen to act as the key 
server. The CD’s opening screen will appear. (If the CD 
does not automatically open, on the taskbar, click the 
Start button, and then click Run. Type the letter of the 
CD-ROM drive followed by CDSetup.exe (e.g., 
D:\CDSetup.exe).

4 On the opening screen of the CD, select the product to 
install and then click the Install button. Follow the 
instructions displayed on the screen to select and install 
the software.

5 Attach the software security key as directed in the 
"Attaching the HASP Key" section on page 2-10.

6 Follow the steps in the "Key Upgrade Procedure" section 
on page 2-12 to upgrade your security key (a required 
step in the upgrade process).

7 In LABELVIEW, select Configuration from the Options 
menu, and then click on the Network tab. Check the Net-

work Key box, and use the  button or Auto Find... 

button to browse to the mapped letter drive location of the 
program’s LICENSE directory.

8 Close LABELVIEW.

9 On the computer that has the key attached, run the 
LVLICENSEMANAGER.EXE application found in the 
LABELVIEW 8.0 program group. (For information on 
running License Manager as a service, e-mail 
teklynx_support@teklynx.com with a Subject line of 
“License Manager as Service”.)

Select the previous LABELVIEW installation direc-
tory (e.g., the LVWIN70 directory) during instal-
lation in order to retain any existing configuration 
settings.
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10 Start the LABELVIEW software. If the key server install is 
configured properly, LABELVIEW will open without error, 
and License Manager should reflect one user accessing the 

program. If unsuccessful, refer to Appendix A, "Trouble-
shooting Installation Issues" before continuing.

11 Install the software on each workstation where the label 
design software will be used. Through Windows, map the 
network drive where the label design software is installed 
on the server or on the workstation where the key is 
attached. Refer to your Windows documentation or ask 
your system administrator for the necessary instructions. 

12 For each installation repeat Step 7. Only this time, browse 
to the program’s LICENSE directory on the mapped letter 
drive from Step 11.

13 Shut down and restart the label design software to com-
plete the network installation.

14 If desired, proceed to the "Setting Up System Security 
(Pro and Gold Only)" section on page 2-13 to set up user 
security.

Network/Multi-
User: Additional 
License Upgrade

1 Follow the steps in the "Key Upgrade Procedure" section 
on page 2-12 to upgrade your security key and add addi-
tional licenses.

2 Install the software on each workstation that does not 
already have the LABELVIEW software installed. Through 
Windows, map the network drive where the label design 
software is installed on the server or on the workstation 
where the key is attached. Refer to your Windows docu-
mentation or ask your system administrator for the neces-
sary instructions. 

3 Insert the CD. The CD’s opening screen will appear. (If the 
CD does not automatically open, on the taskbar, click the 
Start button, and then click Run. Type the letter of the 
CD-ROM drive followed by CDSetup.exe (e.g., 
D:\CDSetup.exe).
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4 On the opening screen of the CD, select the product to 
install and then click the Install button. Follow the 
instructions displayed on the screen to select and install 

the software.

5 Start the LABELVIEW software. (You may see errors upon 
opening, before the network configuration has been per-
formed).

6 Once LABELVIEW is open, select Configuration from the 
Options menu, and then click on the Network tab. Check 

the Network Key box, and use the  button or Auto 

Find... button to browse to the mapped letter drive loca-
tion of the program’s LICENSE directory on the mapped 
letter drive from Step 2.

7 Close LABELVIEW and restart to complete the network 
install.

8 Install and select your printer. (For information on printer 
setup, see Chapter 3, "Printer Setup").

9 If desired, proceed to the "Setting Up System Security 
(Pro and Gold Only)" section on page 2-13 to set up user 
security.

Attaching the HASP Key

The software includes a security key, also called a HASP
(Hardware Against Software Piracy) key or dongle, that must
be installed on a computer to run the software. The HASP key
holds an encrypted code which is deciphered by the
LABELVIEW software to determine settings such as licensing,
release version, full design or print only version, and the
edition information of the software that has been purchased.

Note The HASP key is not related to the location or number of 
printers. LABELVIEW is licensed for concurrent users and not 
per seat.

Without the HASP key, the program will run in 
Demo Mode and will place a demo message on all 
labels printed with the software.
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The HASP key is easy to use — simply connect it to the
appropriate port (parallel port or USB port, depending on the
type of key you purchased) before launching the software. If
attaching a USB key, note that when connected properly it
should light up to indicate that it has been recognized by the
operating system.

If a printer will be attached to the same port, connect the
printer cable to the HASP key. The printer may need to be
powered on before the key is recognized.

             

Figure 2-1 Connecting the HASP key to the parallel port

Figure 2-2 Connecting the HASP key to the USB port
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Key Upgrade Procedure

In order to upgrade a keyed product, you must first upgrade
the HASP key using the following steps.

Note The Key Upgrade procedure works only with HASP keys.

1 On the computer with the key attached, in the LABELVIEW 
software, on the Help menu, click System Status, and 
then click the Upgrade Version button.

The Key Upgrade dialog box appears, displaying your 24-
digit Key Code.

2 Send an e-mail to customerservice@teklynx.com with the 
word UPGRADE in the subject line and include the follow-
ing two pieces of information in the body of the e-mail:

• Authorization Code (obtained from the Key Upgrade 
Program sheet included in your product box)

• Key Code (displayed on the Key Upgrade dialog box)

You will receive a return e-mail from TEKLYNX Customer 
Service with your new Upgrade Code.

3 Enter the new Upgrade Code in the box provided (on the 
Key Upgrade dialog box accessed in Step 1) and click 
Upgrade.

The message “Upgrade was done successfully” appears 
when your key upgrade is complete.

4 Label your key with the provided key label (opposite side 
of serial number) and follow the steps in the "Registering 
Your Software" section on page 2-16 to register your new 
product version.

If for any reason you have any problems with the Key Upgrade
procedure, please contact TEKLYNX Customer Service at 888-
629-4444 or e-mail customerservice@teklynx.com.
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Setting Up System Security (Pro and Gold Only)
The system security feature allows you to restrict users to 
certain features of the program. You can set up system 
security by assigning a user ID and password and then 
selecting the tasks the user may perform. When you 
restart the program after setting up a user, the security 
feature is enabled, and all users will be required to log in 
before using the program. 

X To set up system security:

1 On the key server, start the LABELVIEW software.

2 Set up all LABELVIEW configuration options as follows: 

• On the Options menu, click Configuration. Use the 
tabs on the Configuration dialog box to set up all 
LABELVIEW configuration settings that you want to be 
available for all users (i.e., network licensing, printing 
options, display language, etc.).

• On the Options menu, click Directories. Use the 
Directories dialog box settings to specify the direc-
tory paths of the files you want to be available for all 
users.

• Configure any other Options menu settings (serial 
files, accumulator files, label inventory, etc.) that you 
want to be available for all users.

New in LABELVIEW 8, the program assigns EACH 
USER with his or her own unique configuration 
file instead of using one configuration file for all 
users. For this reason, before adding system 
users and assigning access rights, you must first 
specify the LABELVIEW configuration settings you 
want to be available to ALL USERS. These set-
tings will be saved in the initial configuration file 
(named label.ini), which will be copied to each 
user to generate their unique configuration file. 
After the label.ini file is copied to a user it is then 
renamed using the following naming convention: 
PCName_UserName.ini.
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3 After all configuration options are set, close LABELVIEW to 
update the label.ini configuration file with the new set-
tings.

4 Restart LABELVIEW.

5 On the Options menu, click Security.

6 Click New. 

The Edit User Information dialog box appears.

Figure 2-3 Edit User Information

7 Enter a User ID in the User ID box. 

For example, for the administrator the User ID might be 
“Admin.”

8 Enter a password in the Password box. 

If you intend to set up system security, you must 
first designate a user who will have access to the 
entire system. Without this “administrator” 
access, you can become inadvertently locked out 
from all or portions of the program. 
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Note The User Id and Password are each limited to 10 characters. 

9 Set up access privileges for this user by selecting the 
appropriate check boxes. 

For example, for the administrator you would want to 
select all the check boxes to allow access to the entire 
system and all system tasks. 

10 Click OK. 

The System Security dialog box appears displaying the 
new user. 

11 Repeat Step 6 through Step 10 above to add each user.

12 Click Exit to return to the design window. 

13 Close LABELVIEW.

14 Restart the LABELVIEW software. When you restart the 
program, you will be prompted for a password.

15 Log on to LABELVIEW as each user, which will generate 
the user’s unique configuration file and ensure that the 
configuration options set in Step 2 are transferred to each 
user’s .ini file at this time.

Viewing the Readme File

The Readme.txt file delivered and installed with the software
contains information about the most recent changes and
updates to the label design software that were made after this
manual was printed. This information supersedes what is
contained in this manual.
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Registering Your Software

Registering your software not only provides you with free
Technical Support options, but it also ensures you are notified
of critical updates and patches as they are released. 

X To register your software:

1 In LABELVIEW, click on the Help menu and then click 
Register your product.

2 Select the desired method of registration and follow the 
instructions displayed on the screen.

Note You can also register online at http://www.teklynx.com under 
SERVICE & SUPPORT.
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Printer Setup

LABELVIEW 8 supports over 1,000 specialized thermal and
thermal-transfer label printers and any printer with a valid
Windows driver supplied by the manufacturer. Printer drivers
included with this label design software are installed to the
program’s Drivers directory when the program is installed.

For optimum results when designing and printing labels in this
label design software, use one of the high speed printer drivers
installed with the program.

Selecting a 
LABELVIEW Driver 
for Printing Labels

1 On the File menu, click Select Printer, and then click 
Install.

The Install Printer Drivers dialog box appears.

For thermal and thermal-transfer printers, use 
only the drivers that are installed with LABEL-
VIEW. If you use a driver that was installed 
through Windows, you may experience slow 
printing or encounter errors at print time.

e
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Figure 3-1 Install Printer Drivers

The printers appearing in the Printer Model list depend 
on the check box settings below it. 

2 Check to make sure that both the Native drivers-(V) 
and Extended drivers-(X) check boxes are selected in 
order to view all available drivers.

Some printers include both a native driver and an 
extended driver for the same printer model, designated in 
the program as follows:

(V) = Driver is a native software driver (developed specif-
ically for use with this label design software)

(X) = Driver is from an extended driver set

If an extended (X) driver is selected, you can 
access the printer driver’s advanced properties, 
allowing you to take advantage of the most pow-
erful capabilities of the printer. To access these 
properties, click the Settings button on the Edit 
menu > Label Setup > Options tab (an 
extended (X) driver must be selected in order for 
the Settings button to appear).
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3 Using the Available Printer Drivers lists, select your 
printer’s manufacturer and model.

4 With the desired printer selected, click Install. 

The printer driver appears highlighted in the Installed 
Printers list.

5 By default, new printers are assigned to the local LPT1 
port. If your printer is not connected to LPT1, click 
Connect and select the correct port. Adjust the settings, 
if necessary, according to your printer documentation.

If the printer is connected to a serial port, click the 
Setting button to configure the driver to match the 
printer device settings (baud rate, data bits, stop bits, 
parity, flow control). The printer and the computer MUST 
be set to exactly the same values. Check your printer 
documentation for the correct settings.

Note To function properly, many serial printers need to be physically 
connected with a null modem cable or null modem adapter on 
a standard RS232 cable.

6 Click OK, Close, and OK to return to the design window.

The selected printer appears in the Status bar. Printer 
device settings—such as print speed, paper feed mode, 
and cutter options— are defined during label setup on the 
Edit menu > Label Setup > Options tab. 

If your label was designed for a different printer, 
a message will appear asking if you want to mod-
ify the label. Click Yes to convert the label to 
work with the currently selected printer. The 
changes made for the conversion will not be per-
manent until you save the label. You may need to 
do some fine-tuning if the label conversion is not 
exact, so be sure to print a test label before you 
commit to a large print run.



Troubleshooting

A

Installation Issues

The following Problem/Solution table lists the most common error messages, issues,
and questions encountered when installing the LABELVIEW software. 

Problem Solution

Error: Could not find the Key In some instances, the driver reading the 
HASP key (hardware security key) is not 
updated properly. To upgrade your HASP 
driver, go to http://www.teklynx.com/
support//faq/faq_193.html and download 
the HASP Upgrade Wizard. Follow the 
instructions to upgrade the driver.

For step-by-step instructions on resolving 
Demo Mode issues, view the “LABELVIEW in 
Demo Mode” eHelp video at 
http://www.teklynx.com/products//labels/
labelview_faq_videos.html.

Message: This 30 day Evalua-
tion...

Program running in Demo 
Mode

Error: This Key is not a Net-
work Key 

Within the security key is an encrypted 
code. This code contains the licensing, 
release, full design or print only, number of 
users, and edition information of the soft-
ware that has been purchased. This infor-
mation is printed on both the label on the 
security key and the label on the back of 
the LABELVIEW Quick Start Guide.

e
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Error 5032: No more licenses 
available on this Network 
Key right now

Please verify that you have purchased and 
installed a network/multi-user copy of 
LABELVIEW. (The number of users is printed 
on the HASP key.) 

If you do have a network copy, open the 
License Manager program on the key server. 
If License Manager is showing the correct 
number of users but you see the error: 
“LABELVIEW is unable to write to the 
C:\Program Files\LV8\System\License 
directory due to permission or security 
restrictions,” ensure that all users have full 
Read\Write\Modify rights to this directory. 
All users MUST have full Read\Write\Modify 
rights to this directory in order to allocate a 
license.

If License Manager is showing an incorrect 
number of users, please contact your 
reseller.

Error 5001 nn: Server not 
found

The network installation has not been com-
pleted on the key server. Launch License 
Manager and verify that the number of 
users matches the number of users printed 
on the HASP key label. On the key server, 
open LABELVIEW and go to Options menu 
> Configuration > Network tab. Check 
the Network Key box, and for the Server 
Location, browse to the mapped letter 
drive location of the program’s LICENSE 
directory. Click OK, and then restart the 
program. 

Error 432: Setup has 
detected that InstallShield is 
in use. Please close 
InstallShield and restart 
setup

This is an InstallShield error that can occur 
for a number of reasons. For information on 
resolving this issue, go to 
http://consumer.installshield.com and 
search on “Error 432”.

(Table continued from previous page)

Problem Solution
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Options greyed out or not 
available

Many of the features covered in the LABEL-
VIEW Quick Start Guide and online Help are 
available only in the mid-range (Pro) or 
high-end (Gold) editions of the software. If 
an option appears “grayed out” and is not 
available for selection, this is most likely 
because that feature is not included in the 
edition you purchased.

A complete list of features included in each 
edition can be found in the "LABELVIEW 
Editions" section on page 1-2 of this guide.

I lost the CD, how can I 
install?

If you have lost the CD and need to re-
install, you can download the latest version 
of the software from the TEKLYNX web site 
at http://www.teklynx.com. Please verify 
that the version number printed on your 
HASP key label matches the Demo version 
(the Demo available on the web site is 
always the most current version of the soft-
ware). As long as the versions match and 
the key is properly attached, the Demo file 
is all that is needed to re-install the soft-
ware.

How do I know that the CD I 
received contains the latest 
release of the software, 
including any recent patches 
or updates?

You can verify this by checking your soft-
ware version number against the version 
number of the LABELVIEW Demo found at 
http://www.teklynx.com. The LABELVIEW 
Demo is always updated with the most 
recently released version of the software. 
Please verify that your HASP key version 
matches the Demo version. 

I do not have a Parallel or 
USB port that matches the 
HASP Key that came with my 
software. What can I do?

We do not recommend or support port con-
verters for use with HASP keys. If you do 
not have the appropriate port available on 
your computer, please contact Customer 
Service at 888-629-4444 or e-mail 
customerservice@teklynx.com.

I have more than one 
printer, but only one HASP 
Key.

The HASP key contains the version, edition 
and number of licenses available. It is not 
related to the number or location of the 
printers you will be using. 

(Table continued from previous page)

Problem Solution
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Where can I find samples/
templates, training manuals, 
and tutorials? 

Sample label design files and compliance 
label templates can be found in the pro-
gram’s Samples folder (i.e., C:\Program 
Files\LV8\Samples).

Both BASIC and ADVANCED level training 
manuals (including step-by-step tutorials) 
are available from TEKLYNX for a fee. For 
more information, please contact TEKLYNX 
Customer Service at 888-629-4444 or 
e-mail customerservice@teklynx.com.

Why should I register my 
TEKLYNX Label Design Soft-
ware?

Registering your software not only provides 
you with free Technical Support options, but 
it also ensures you are notified of critical 
updates and patches as they are released.

It is easy to register your TEKLYNX soft-
ware. See the "Registering Your Software" 
section on page 2-16 for more information.

What Technical Support is 
available? 

For 24 hour access to TEKLYNX Technical 
Support resources, go to 
http://www.teklynx.com and click on the 
SERVICE & SUPPORT menu. This section of 
the TEKLYNX web site offers many support 
resources including PDF format manuals 
and guides, Technical Support FAQs, eHelp 
videos and more.

For phone support, please contact your 
label design software supplier.

(Table continued from previous page)

Problem Solution
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For technical support contact your LABELVIEW software reseller. Online support is available free of charge at www.teklynx.com under SUPPORT. Copyright 2005 Braton
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All other brands and product names are trademarks of their respective owners. (Y453734)
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